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Welcome to our first session.1

Word Processing 

Word processing is the creation of documents using a word processor.

A word processor is a computer program used for the production of any sort of printable material.

The Word Processor we are using is part of the LibreOffice Suite. It is called simply Writer

Before we start we first need to know how to launch (Start) Writer. The first task is to open Writer. 

The easiest way to do this is via the start menu. So click on the start button, look for Writer and click 

on the icon. If you don't see it then look in All Programs, then LibreOffice and finally click on  Writer.

You will see the main Writer window.

1 You will need the files Tips and Tricks and Spelling downloadable (Free) from www.giakonda.org.uk if you 
want to complete the exercises. 
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The Writer Screen

Cursor where you start 

typing

Ruler

Views

Scroll bar

Zoom

Ribbon

Title bar

Status bar
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The main features of the Writer screen are:

The Title bar. This is the blue bar across the top of the screen. It is called the title bar because it 

contains the title of the application you are running, in this case Writer and also the title of the 

document you are editing. If you have just started using Writer the document title is Untitled1. 

Usually you will save this document with a new name before you start to write it. The title bar will 

then contain the file name you have given to the document.

On the right of the title bar are the Control Buttons, Minimise, Restore down/Maximise and Close. 

These allow you to control the size of the Writer window and to close it all together.

The Ribbon The ribbon is a set of

tools that each, in turn, focus on some aspect of Word-processing. 

If your screen size is limited you will find a chevron at the end of the ribbon. Clicking this will give

you the tools which were not able to fit your screen.

Note: The tools visible on the Ribbon will depend on how Writer has been customised and the 

version you are using

The Sidebar

To the left we have the default sidebar

To the right are some of the alternative sidebars.

These are very flexible and well worth the effort

of exploring
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Keyboard controls allow you to use keyboard short-cuts to do things more quickly

If you are the sort of person who likes to use a keyboard rather than a mouse then you can do so by 

using the Ctrl key and pressing the appropriate key. For example pressing the Ctrl key followed by a B 

will set the character format to Bold

The Ruler is useful to position text accurately

For doing accurate work, particularly with word-processing tabs, it can be essential to see the 

distance between points on your document. The Ruler provides the means to do this. If you don't 

have the ruler displayed then click on the View Tab, look for the Rulers and then check the ruler you 

want, either the normal ruler across the top or even the vertical ruler place a tick in it by clicking on 

it.

The Status Bar 

At the bottom of your document is the Status Bar. This is where you find current details of your work.

It contains information such as the current page and the number of pages in your document and the 

number of words you have typed so far. On the right of the Status Bar are the various page views 

(Single page , Multiple page and book view) that are available. The Zoom Bar is used to increase and

decrease the size of your page.

Single page view Multi page view Book view Zoom bar %Zoom
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Getting Help
You can get help by using the help Icon at the top right of the screen or by pressing the function key 

F1 (Help works best when you are connected to the internet).

The fuller version of help, seen below, is displayed by clicking the book icon when the help is first 

displayed.

If the Built in help is not installed on your computer pressing the F1 key will display

Note: You must be connected to the internet to read the help online.
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Editing Documents
One of the main advantages of any word processing package is being able to change text by moving it

around or copying it between documents.

Deleting and Moving text 
If you don’t want to use the text you are deleting simply select it (by holding down the left mouse 

button and at the same time swiping the mouse pointer over it) and then press the Delete or Del Key.

You can delete words (rather than characters) to the left of the cursor by holding down CTRL and 

pressing BACKSPACE.

Should you want to use the text in another place then you can make use of the  Clipboard.

This is a feature of most applications. It lets you move things from one place to another even 

between different applications.

The general term for this work is Cut and Paste though it also includes Copy

Cut, Copy and Paste are on the  main ribbon.

Cut deletes the selected items and places them in the clipboard.

Paste places the contents of the clipboard in the new location.

Copy places the selected items in the clipboard but does not delete them.

The keyboard shortcuts for this are:

Select  Shift and the arrow keys to select text. 

Cut Ctrl +x (think of the x as a scissors) to cut the selected text.

Paste Ctrl + v (moVe) to paste the object in a new location.

Copy Ctrl + c to Copy the selected text.

If you select any text and right-click, Cut, Copy and Paste are the top options in the pop-up menu.
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The paintbrush is the Format painter NOT the Paste command

 Open the document Tips and Tricks.docx and place the bullet points in their correct 

locations.
 Once completed save the document as Tips and Tricks completed.

Often Cutting and Pasting can cause a few issues. Remember you can always use the Undo function

to go back to your original
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Drag and Drop
This is a quick alternative to using Cut and Paste.

 Select the text to be moved(by holding down the left mouse button and at the same time 

swiping the mouse pointer over it)
 Place the mouse pointer over the text, now with a blue background

 Hold down, continuously, the left mouse button and Drag the pointer to the new location for

the text
 A grey vertical line and a grey box will show where the text will appear in the document

 Release the mouse button and Drop the text in its new position.
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Undo and Redo
You will find these essential features on the Ribbon.

Undo  (CTRL + Z) Choose this if you make a mistake and want to undo it, 

Redo  (CTRL + Y) Lets you repeat the last action you did or cancel the last thing you undid. 

Using Cut, Copy and Paste

 Open document word processing tips.docx

 Using cut, copy, paste, drag and drop, rearrange the document so the paragraphs are in 

numbered order
 Headings should be Cambria, 22pt, bold

 Make the body text 12pt.

Basic Formatting
Most of the formatting you will do on a day to day basis is on the main ribbon. As long as you are 

editing text you will see the tools in front of you. 

Note: You won’t see these tool if you have clicked on a picture

These are all the tools you see

Character formatting

Bold, Italic, Underline, Superscript, Highlighting and Colour of text are all found in the ribbon.

These tools are the Character formatting tools. You have to highlight some characters first in order to 

change their properties, font, bold, underline etc.

From left to right  Font (Calibri here) Size (11 means 11 points and a point is a 72nd if an inch) Bold , 

Italic, Underline, Strike-through, Superscript, Subscript, Clear direct formatting, Character colour and 

finally Highlighting colour.
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Paragraph Formatting (more detail on this is found further down the document)
Paragraph formatting refers to the whole paragraph. That is from the start of a new line to when you 

key the enter key again Any change in the paragraph such as indenting will apply to the whole 

paragraph not just to the line where the vertical cursor is. (This line is called the caret or insertion 

point)
The tools for formatting paragraphs are

Bullets and Numbering

As you will notice there is a small downward pointing triangle along side the bullets.

If you click on the triangle you get more choices than just the dots and numbers

Justified Margins
The next four tools set the justification of the paragraph

From left to right Left Justified (also referred to as Left Aligned), Centred, Right Justified (Also referred

to as Right Aligned) and Fully Justified
If the paragraph is not Fully Justified the side that goes in and out is referred to as having a ragged 

margin

Line Spacing

Set line spacing, increase and decrease paragraph spacing

Indentation

These two tools simply Increase and Decrease the paragraphs indent.
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Paragraph Formatting (more detail)
A paragraph is all the text that is entered between each press of the ENTER key. When you type with 

Writer you do not need to press the enter key when you reach the end of a line. Writer takes care of 

that for you.

The end of the paragraph is marked by the pilcrow 

You will only see this if it is active

You turn this on by clicking the tool on the top centre tool bar

To change the format of a paragraph select the Format drop down menu and click Paragraph. This 

will open the Paragraph dialogue box,

The basic functions of changing the paragraph are displayed by selecting the appropriate tab.

 Paragraph formatting changes the entire paragraph. The caret only needs to be in the paragraph for 

changes to take effect.

What tools are available under each if the tabs is found in the appendix.
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Bullets exercise

 Open the document Tips and Tricks No Bullets.

 Under Word-processing guidelines, for paragraphs three to seven add bullets of your choice. 

You can always undo any changes and retry with a different bullet.
 Under Word-processing tips, for paragraphs two to six try using numbered lists. Again use 

undo to test out your choices.
 Save the document as “Tips and Tricks bulleted” in a format readable by someone who has 

Word 2003. Don’t close the document.

Borders and Shading exercise

 Using the same document, Tips and Tricks Bulleted, add a shaded border to the titles,Word-

processing guidelines and word-processing tips. Choose a colour of your choice. Centre align 

the text in both cases.

Borders and Shading can be used to emphasise a section of work as here

Create a new document.  
Now open the paragraph dialogue box and change the Spacing After to 0 pt. Observe the 

effect. Similarly change the Line spacing to different values and again observe the effect.
Change the Indentation to First line indent 1.27 cm
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Find and Replace
Editing documents often requires searching for particular words. It is easy to miss words in a long 

document. Writer has a Find and Replace function that lets you search for some text and even 

replace it with another. 

Find and Replace are in the Edit drop-down menu, (keyboard shortcut Alt E)

Finding
Select Find from the Edit menu.

A pane will open up to the left of the document. Put the word you are searching for in the search 

area.

Use the up and down arrows on the left to look for next or previous occurrences of the word.

Replacing
Replace is very similar to Find but it gives you the option of changing the word searched for.

 Open the document word processing.docx

 Use Replace to change all instances of dialog to dialogue

 Use Replace All to change all instances of the word tips to advice

 Check the final paragraph of the document to see the dangers of using Replace All unless 

you are sure the word you are replacing is unique
 Use Undo to change advice back into tips

 Click More to see additional options

 Use the Format Option to search for text in italics.

Page 16



LibreOffice series GiaKonda Solar Schools

Using Tabs
The final element of the paragraph formatting is Tabs.

Look for the Tab in the paragraph dialogue box and click it.

These are used to accurately place text 

and numbers on lines. When using tabs 

it is usual to place the caret on the line 

where you want the tabs to start, then 

Set them within the tab dialogue box. 

When all the tabs have been Set click 

OK to accept them

The tab positions will be carried over 

from one line to the next as you press 

enter. 

Alternatively, you can set tabs on a block

of text by highlighting it and then setting

the tabs. Of course, you will have to 

press the tab key appropriately in each line to achieve the effect you require.

The lines below are tabbed at 2 cm and 12 cm with the 12 cm tab also being centred and having the 

leader 2. 

 Reproduce these two pieces of work in a new document.

 Save the document as tabs.docx

First meeting .....................................................................June 2, 2001

Second meeting............................................................. January 25, 2002

Third Meeting.................................................................. March 3, 2002

Try the lines below with tabs at 2.5 cm (left aligned) and 12 cm (decimal aligned)

Biscuits..............................................................£.25
Pies..................................................................£7.00
Roast beef.....................................................£15.99

Space the lines better by choosing a paragraph spacing after of 6 pt.
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Page Layout
The page layout options are found in the Format drop down menu under Page. The options we will 

consider are under the Page tab

Note: All the tabs in this dialogue box apply to page layout options

Margins
Margins are the spaces around your body text. Normally this is 2.45 cm, top, bottom, left and right. 

Usefully Writer has several pre-set margins. These are found by clicking Margins in the Page Setup 

group on the Page Layout ribbon.

Normal Margins are displayed these are usually sufficient for most purposes.

If you want to apply a particular set of margins you can change the values in the appropriate boxes 

from the bottom of the drop down.

 Create a new blank document

 Set in turn each of the margins to values of your choice

 Observe the effect this has on your text
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Page Breaks
Page breaks are useful if you want to start a new page without filling the one you are on. The 

simplest way to do this is with the keyboard shortcut Ctrl <enter> In the Insert drop down menu 

ribbon the Page Break tool, at the very top of the list, will allow you to insert a page break. While 

directly below that the Manual Break tool will let you create a new page while others, Column break 

for instance, will not generate a new page (referred to as continuous breaks). 

Size and Orientation

Size
Generally the size of paper in Europe is A4. As you might guess this can be set to several different 

sizes but remember whatever size you set your paper to be you must have a printer capable of 

printing it.

Orientation
Writer pages can be either Landscape or Portrait. These can be found by clicking Orientation in the 

Page dialogue box 

 Change the orientation of your page to Landscape then back 

to Portrait
 Observe the effect this has on your text
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Columns
Writer starts off with single column format. This can be changed if required to two column, or even 

three column format. Changing the number of columns will affect the whole of the document unless 

section breaks (see later) are first applied to mark off the section which is to be changed.

Breaks
Section breaks are applied to quarantine a section of your document in order to apply changes that 

would otherwise affect the whole document. For example in this document page 4 is actually 

Landscape. To do this only for page 4 it was necessary to place a Section Break (Next Page) at the 

end of page 3 and again at the end of page 4 before applying the Landscape Orientation to page 4.

The Next Page type of Section Break had to be used because it is not possible to have Landscape and 

Portrait orientation on the same page at the same time. 

Hyphenation
By default Writer does not Hyphenate but it is possible to apply Automatic or Manual Hyphenation.

If Automatic Hyphenation is applied it can be turned off in the Hyphenation Options within the Page 

Layout group
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Hyphenated words that you want to stay hyphenated are placed by 

holding down Ctrl and Shift as you type the hyphen. These are referred to as Non-breaking Hyphens.
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Adding Objects to Documents
This session we are going to focus on adding objects to Writer. An object is an element of word 

processing over and above normal text. Strictly even a character is an object. 

The feature to remember is that all objects have properties and these properties can be changed. For

example, a picture is regarded as an object. Its properties are many, for example, its size, its border, 

its position and style. 

All these objects can be accessed using the Insert tab 

Inserting Headers and Footers
Headers and footers are the pieces of text that appear on the top and bottom of each page of a 

document. 

Click the Header button on the Header & Footer group of the Insert ribbon. 

Examine the selection of standard headers that are available and choose one for your document.

Repeat the process but for the footer,

If all you want is page numbers then the Page Number button can be used to provide a set of page 

numbering options.

Once Headers and Footers have been inserted into a document they can be seen, albeit greyed out, 

on the top and the bottom of the document. To access the headers and footers of a page simply 

double-click on the header and footer area. To get back to the body text again, double-click in the 

body area.

Inserting Pictures and Clipart
Click on the Picture button in the Illustrations group. From the Dialogue box that appears navigate to

a picture of your choice and insert it. 

Select the image by clicking on it.
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Note the handles that appear around the image. These are used for resizing the image. The green 

offset handle is used to rotate the image.

If you click on the insert clipart button you are presented with the Clipart Task Pane this allows you 

to search for clipart both on the local machine and, if connected, on the internet.

 Exercise 

 As in the example above search for a clipart image that 

is tagged Flowers and insert an image that you like into 

your document.

Notice the same handles that appeared around the picture are 

present here also. They have the same use.

Resizing a picture

Position the mouse over one of the handles until the pointer 

changes to a double-headed arrow

 Drag the pointer to resize the picture

Picture Styles

 Mouse over or click on some of the Picture Styles and 

observe the effect

Position

 Use the Position tool to position the image is several 

different places

Size

 Set the Height and Width of your image using the boxes in the Size group
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Inserting Shapes
Select the Shapes button from the Illustrations group. As you can see from the diagram below there 

are many different shapes available.

You can create simple objects like lines and circles or use built in shapes 

(AutoShapes) that offer more complex shapes.

Shapes have the same handles as other objects such as pictures and clipart. 

However some have an additional yellow diamond adjustment handle that 

allows you to modify the shape in additional ways.

 Create a new document 

 In the Insert ribbon select Shapes from the Illustrations group and 

choose a simple shape, say a rounded rectangle.
 The cursor becomes a black cross. Use the left-hand mouse button to 

drag the cross to create the shape.
 Move and resize the shape with the move cross and the resize handles.

 Feeling adventurous? try rotating the shape 

There are three layers on your new page: the text layer, a layer below the text and a layer above the 

text. We will look at these layers later.

Formatting Shapes
Once you have inserted a shape you will notice a new Ribbon Tab. The Drawing tools Format ribbon 

allows you to add many formatting features to your shapes.

Select a shape and apply the Shape Outline button to change the Weight (thickness) Dashes and 

Outline colour of the shape.

Use the Shape effects to add drama to your shape.

Finally, add text by selecting the shape and simply typing.

Experiment on other shapes in your document.

Deleting Shapes
Select the shape and press the Delete (Del) key
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Layering Shapes
As you create objects they are added to the document a layer at a time. The successive objects are 

layered on top of the previous objects.

Create three shapes similar to those below. Make sure they overlap each other.

Click on the shape covered by the others. In this 

case the square. In the Arrange group of the 

Drawing Tools Format ribbon click on the Bring 

Forward icon then select Bring to Front. This will 

place the square to the front of the other two 

shapes. 

 Experiment with moving these shapes to the front and then progressively to the back

In the Drawing Tools Format ribbon, on the Arrange group, there are many buttons that provide you 

with the ability to rearrange the order of the objects as well as giving 

you the opportunity of determining the way text will flow around your objects. As you 

can see from the text and objects here you can 

produce some interesting effects. The Text Wrap

style here is called Through which is why the 

text wraps the way it does. Tight would take the 

text away from the objects. It is well worth 

experimenting with the way different text wrap options 

work.

 Use the =rand() function to produce some text. 

 Insert into this text various objects and experiment with the way the text changes with the 

various wrap options.

Grouping Shapes
Grouping shapes is useful if you want to keep the layout of several objects.

Select each object by holding down the shift key and clicking on the object. As long as you hold 

down the shift key you can select as many objects as you want.

Once you have selected all the objects you require select (from the Arrange group on the Drawing 

Tools ribbon) the Group button and click Group again to form them into one object.

Ungrouping is done by selecting the grouped object and clicking Group then Ungroup.
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Inserting Smart Art
Select SmartArt from the Illustrations group.

From the Process section chose the fourth option Accent Process.

Type the list below into the text box on the left. (You could also type the text directly into the

graphic itself.

Save your work as H&S road map. 

Health and Safety Road Map

Decide who will help

Yourself

One or more of your workers

Someone from outside your business

Manage the risks in your business

How do I assess the risks in my workplace?

Don’t forget to consider everyone who could be harmed

Specific risks

Consult your employees

Health and safety and the work they do

How risks are controlled

The best ways of providing information and training

Provide training and information

Hazards and risks they may face

Measures in place to deal with those hazards and risks
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How to follow any emergency procedures

Your finished work should look something like this (with the fourth box included!)
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Inserting Charts
Charting in Writer uses a cut down version of Excel. Select Chart from the Illustrations group in the 

Insert ribbon. This will present you with a basic chart that can be modified to suit the data you have. 

If you need a bigger or smaller data range this can be achieved with the blue table borders by simply 

dragging them to the required position.

Charts based on Excel can also be inserted into a word document. These are covered as part of the 

advanced course.
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Proofing Tools (Spelling and Grammar Checks Thesaurus)

Spelling Checks 
After you have entered a document, you should always check the spelling. Writer comes with a built-

in spell checker to help with this. It can be found on the Review ribbon in the Proofing group

Writer checks spelling as you type by finding words in your document 

that do not match those in its dictionary. If automatic spell checking is 

turned on (which it is by default), incorrect words will be marked by 

wavy red underlining.

This is my documnt.

If you have any proofing errors (spelling or grammar) in your document,

the status bar will show an open book with a red cross on it. Clicking on

the button will take you to the first error to correct

it. This method is only useful for a short document

with few mistakes, as you have to correct each

mistake separately.

Writer also checks for:
Repeated words (e.g. to to)
Oddly capitalised words (tHE)
Proper names (e.g. swansea)

You can set additional options in the Spelling Dialog box.

Autocorrect and automatic spell checking
Some mistakes can be corrected automatically by Writer. These include some common spelling 

errors.

Type in the word “documnt”. The word will automatically correct itself.

Now type in choie

Right-click on the word (it will be underlined in red). A box will open up offering suggestions. Select 

the correct word from the list of suggestions.
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The Spelling and Grammar dialog box
The Spelling and Grammar button launches the spelling and grammar dialogue box. It is found on 

the Review ribbon in the Proofing group. Use this when you have a long document. To check the 

spelling of a specific word or phrase, select it first or the checker will check the whole document. 

You will find the Spelling and Grammar Option on the Review tab (the Proofing group).

 Click the Spelling and Grammar Button

OR
 Press F7

 The Spelling and Grammar dialog appears with the first misspelled word highlighted in red.

Writer searches through your document matching each word against the words in its dictionary. It 

will highlight any words it does not recognise in the Not in Dictionary box. You have these options:

Change/Change All  If the correct spelling appears in the Suggestions box, select it and click 

Change. If there several occurrences of the same mistake, click Change All.

Ignore/Ignore All Choose this to leave the word or words unchanged.

Add Choose this option if you want to add the word to the dictionary. (Make sure 

it’s right!)

Autocorrect Click Autocorrect for Writer to change it automatically in future. (Make sure 

that the correct spelling is selected in Suggestions box)

Exercise: Spelling

 Spell check the document spelling.docx

Grammar Check
You can use Writer grammar checker to help spot grammatical errors and suggest how to correct 

them.

As with the spell checker, you can choose to have Writer automatically check as you type. Any text it 

finds that does not follow certain grammatical rules is underlined with a wavy green line.

If you do not have automatic grammar checking on, you can still check the grammar by running a 

spell check and making sure that Check Grammar tick box is selected. Writer will check the spelling 

and then the grammar.

 To turn on automatic grammar checking you must open the File menu and select Options 

button 
 In the Writer Options select Proofing

 For automatic grammar checking, make sure Mark errors as you type is ticked

 Further options are available in the Settings button next to Writing Style
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Checking grammar is similar to checking spelling. The Options are:

Ignore Once Ignores the word or phrase.

Ignore Rule Skip all occurrences that break the same grammatical rule.

Next sentence Leaves the sentence as it is and move on.

Change Accept the change.

Explain Gives more information about the error. Writer Help appears 

and describes the grammar or style rule, giving suggestions for

changing it.

Options Selects the different rules of grammar and style (the same as 

the Proofing Selections in Writer Options)

Undo Undoes the last correction.

If Writer is unable to offer a suggestion the button is greyed out. You can, however, still make 
changes by clicking into the dialog box and editing the text and selecting the Change button.

Exercise: Grammar checker

 Grammar check the document SPELLING

Thesaurus
When you’re not sure of the meaning of a word, or when you think you’re using the same word too 

often, use the Writer Thesaurus. It defines selected words and offers alternative words (synonyms).

It will also offer Opposites (antonyms).

The thesaurus is on the Review tab in the Proofing group.

 Open the document spelling.docx

 Move the cursor on to the word necessary. (You don’t have to select the word).

 In Review tab, click on Thesaurus.

 The Thesaurus pane appears with a list of alternative words.

 To choose an alternative, highlight the word you want in the task pane and click on the drop-

down arrow that will appear.
 Click on Insert to replace your original word.

 To look up one of the alternatives and see its synonyms, select it and select Look Up or 

double-click on it.
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 Try the thesaurus on other words in spelling.docx

You can also use your mouse to find a synonym. Point at a word and right-click.

From the pop-up menu choose Synonyms (towards the bottom). You can also open the Thesaurus 

from this option.

Custom Dictionary
Words that are not recognised by the dictionary in Writer can be added to the Custom Dictionary so 

that they are not underlined in red.

There are two ways of doing this:

 Right-click in the middle of the word underlined in red and choose Add to Dictionary.

 Spell Check the document and when the word is located click the Add to Dictionary button.
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Tables
Tables are a very useful addition to word processing. It is an excellent way of setting out data without

using the column and tab features. With LibreOffice you can also use tables as simple spread-sheets. 

As with inserting most things in a word document, Tables are found in the Insert Ribbon. The 

simplest way to add a table is to use the matrix under the table icon. 

You simply “hover” the mouse

over the array until the number

of columns and row you require

are highlighted. Here we are

creating a four by five table, i.e.

four columns and five rows. 

You could have clicked on Insert

Table to fill in the dialogue box

with the details you required.

With Writer you also have the option to draw a table using the mouse 

as a pen. Although for some awkward shapes this is helpful I have found it a little messy. 

 Once you have created the table add the headings in the first row as: 

 Title, First Name, Last Name, Address

You move between the cells of the table by pressing the tab key. You move back through the table by 

pressing the shift and tab keys. 

 Enter the details of five people into your table under the correct headings. 

You will notice as you reach the end of the forth person’s details pressing the tab key will create 

another row for you. This will help if you have to add more records to your table. 

Column width and row height
This requires you first click somewhere in the table so that the Table Tools tab appears as a new tab. 

At this point you must select the Layout tab directly below on the right. The Cell Size group will allow

you to set the row height and the column width of any selected row or column.
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Draw table
The Draw table feature lets you draw tables with a electronic pen and 

eraser. It can be selected within the Table selection from the Insert tab, 

as seen above. Alternatively once a table exists, the Draw Borders 

group, Draw Table icon can be used to add cells to the existing table or 

to create a new table 

 Create a 2x2 table then Draw an additional column onto it.

Adding/Deleting Rows or Columns
Select any cell next to the place you want to insert your row or 

column. In the Rows and Columns group click the appropriate icon

to insert the row or column you want.  To delete a Row or Column 

simply select it and click the Delete icon from the Rows & 

Columns group on the Table ribbon. Note the Table ribbon only 

appears if a table is selected.

Merging Cells
Select the cells you want merge then click the Merge Cells icon in the Merge group

To un-merge the cells select the merged cells and click Split Cells in the Merge group

Deleting a table
To delete a table simply select it (Right click in the table and from the drop down menu click Select 

then on the choice menu click Table) then press the Delete (Del) key.

 Create a four by four table with the headings as shown

January February March

Daylight hours 8 hrs. 9 hrs. 11 hrs.

Rainfall 98.4 in 45.2 in 15.0

Temperature 6.6 (43.9) 6.9 (44.4) 9.3 (48.7)

 Add a row to the top of this data above the months. Select the whole of this top row of the 

table. Merge the cells in the top row. Type the heading UK Weather
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Mail Merge
Mail-merge is the process of sending multiple copies of one letter to different clients such that they 

each receive a personalised version.

It involves two parts. First the letter itself (called the Form Letter) and second the individual records 

(called the Data Source) to be added to the letter. These two items are then merged to produce 

multiple personalised copies.

If we use the Data Source

Mr. John Smith, 306 Llantarnam Road, Cwmbran.

Mrs. Gillian Walker, 12 New Street, Llanelli.

Mrs. June Fisher, 6 North Walk, Cross Hands

Mr Fred Evans, The Vicarage, Maesteg

And the Form Letter

Dear <First Name> 

Thank you for the donation to our charity. 

We hope you can continue to support us in the New Year.

Please pass on our good wishes to all in the <Town> Branch.

We would get letters of the sort

Dear John 

Thank you for the donation to our charity. 

We hope you can continue to support us in the New Year.

Please pass on our good wishes to all in the Cwmbran Branch.

For each record in the Data Source

We use the Writer Mailings Tab to help us complete this process.
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Creating a Data Source
If you don’t have a data source, (a file containing the records you are going to use), then you will 

need to type one.

Click mailings tab then click the Select Recipients icon and choose Type New List.

The list generator provided in word by default is setup for the American address system and also 

includes email. If this does not suit your purpose you can use the customise columns button to 

change the column headings. These headings are also called field names. You can add, remove and 

rename the field names to suit the task in hand.

Rename the City to Town, Zip Code to PCode and State to County

Once you are happy with the field names close the Customise Address List dialogue box and enter 

the details of the four people in our example

You can move from one column to the next by pressing the tab key. You can move back a column by 

holding the shift key and pressing the tab key.

When you have done click on the OK button. Writer will prompt you for the location to save your 

data source. Call it Charity Supporters.

Notice that once you have saved the file the Edit Recipients List icon ceases to be greyed out.
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You can now use the Edit the Recipients List to include or exclude people’s records. If you want to 

change the details you have saved you must select data source from the window at the bottom left of

the dialogue box.

Charity supporters.mdb in our case. The .mdb indicates it is in Microsoft database format.

Now move on to stage 2 writing a form letter.

Writing a Form Letter
Copy the letter in our example but omit the word <first name> and <town>. We will get word to 

enter them for us.

Place the caret next to the space after Dear, this is where we will add our first name field  First Name.

Placing Merge Fields in a Writer document
The headings in the Data Source, (Name, Address, etc.) are referred to as “Field Names” because 

each column is called a “Field”. In the example above we can see the fields Title, First Name, 

Company Name and Address Line 1. The process of adding these Field Names to your letter is called 

Inserting a Merge Field. So If I wanted to start the form letter with 

Dear Joe

I would insert the Merge Field <First Name> after the space following Dear. In the form letter It 

would look like 

Dear <First Name>

To insert a merge field click on the Insert Merge Field icon in the Write & Insert Field then select the 

Field name you want to insert from the drop down list that appears.

Make sure you are still on the Mailings tab. In the Write and Insert Fields 

group select Insert Merge Field the following dialogue box will appear. This 

allows us to place any of the fields we have created into any place on our 

letter. As stated we will place the First Name field next to Dear.

Select first name and then click the insert button click the close button. It’s as 

simple as that
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Completing the Merge
Once you have your letter as you want it you click on the Finish & Merge icon to generate your 

letters and either print them directly (Print Documents) or create a file with all the letters in for you 

to possibly review or edit (Edit Individual Documents).

Adding Records to a Data Source
Adding records to your list (Data Source) involves first selecting the Data Source then clicking the Edit

button. When the Edit Data Source window appears click the New Entry button and enter your new 

details. Similarly you can delete a record by clicking the Delete Entry Button.
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Labels
Writer can be used to create labels from any data source though mailing labels are the most 

common. This is what we shall focus on.

Create a new document

Click on the Mailings Tab

Click the Start Mail Merge button from the Start Mail Merge group and select Labels

You now see the Label Options dialogue box. This allows you to choose the type of label you require. 

Avery labels are the most universal and their product numbers are often quoted on other 

manufacturers’ products. Choose the Label vendor Avery A4/A5. Choose the Product Number L7160.

Now we need the details of the people we are sending to so Select Recipients button.

Choose existing list and select the Charity Supporters.mdb data source that we used previously.

Use the Insert Merge Fields button to insert the fields you require.

Once you have set up the first field click the Update Labels button to apply the merge fields to all the

labels.

You can now preview the results using the Preview Results button. 
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Styles
Styles allow you to produce consistent high quality documents. They are essential for long 

documents with multiple headings and subheadings that require the generation of a quick and easy 

table of contents.

Style Sets

Colours and Fonts

Paragraph styles are accessed from the Styles group dialogue box launcher in the Home ribbon
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Ribbon Tools
The tools available on the ribbon will change depending on the object you have selected, Text, Image, Table etc.

Ribbon tools available when working on the body text:
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Ribbon tools available when working on an image

Ribbon tools available when working on a table
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Useful LibreOffice Writer tricks

Some handy tips that you can use with LibreOffice Writer. 

Create instant hyperlinks

I wind up placing a lot of hyperlinks within many of the articles I write, which can be quite cumbersome. You type the text, click on the Hyperlink button, 

enter the URL, click Apply, and click Close. There is a much better way: Use the Hyperlink Bar. To enable this, click View | Toolbars and select Hyperlink Bar. 

This will open a new toolbar that has two simple text areas. The first (to the far left) is where you enter the text for the hyperlink. The second area is where 

you enter the URL. Once you've entered the URL, press Enter and the link will appear to the right of the current cursor position.

Use the Thesaurus

That's right, LibreOffice comes complete with a handy Thesaurus to use as you write. To open up this this tool, highlight the word you need help with and 

then hit Ctrl + F7. The LibreOffice Thesaurus will open with suggestions for the word. If you are using a window manager or have created a custom shortcut 

that uses Ctrl + F7, you can just go to Tools | Language | Thesaurus.

Take advantage of autocomplete

You know that tool on your smartphone that mostly just gets in the way of your trying to type? Well, you can enable it in LibreOffice Writer, only it's not so 

bad. Click Tools | Autocorrect Options. In the Word Completion tab, make sure the Enable Word Completion option is checked. In that same tab, make sure 

the check box for Collect Words is selected. With the latter option checked, LibreOffice will record every word you type so autocomplete will have a 

database of words from which to pull. Now as you type, LibreOffice will complete your words and you just have to hit the Enter key to accept its suggestion.

Know the keyboard shortcuts

Here's the deal. Every application has keyboard shortcuts. Most people know the usual Ctrl + A, Ctrl + V, Ctrl + P shortcuts. But that short list does little in the

grand scheme of things. There exists a huge list of preconfigured keyboard shortcuts for LibreOffice. The best way to learn these shortcuts is to click Tools | 
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Customize and then click on the Keyboard tab. There, you can scroll through the complete list of preconfigured keyboard shortcuts. Go through that list and 

commit to memory those you'll need to use most.

Protect your templates

LibreOffice has a great system for using templates. You can create a collection of them and house them in a shared repository. But when you create them, 

it's a good idea to make them read-only and to password protect them. The last thing you want to do is work hard on a template only to have someone 

overwrite it, causing you to go back to the drawing board. To mark a template as read only and password protect it, open it and click on File | Properties. 

Click on the Security tab and select Read Only. Now click the Protect button and when the new window opens, enter (and re-enter) the desired password.

Create a table of contents

If you're creating larger documents, you should seriously consider creating a table of contents. It may sound complicated, but it's not. To add a table of 

contents, follow these steps:

1. Click in the document where you want to create the table of contents. 

2. Click Insert | Indexes And Tables | Indexes and Tables 

3. Click the Index/Table tab. 

4. Select Table of Contents in the Type box. 

5. Select any options you want and then click OK. 

If you later make a change in the document that must be reflected in the table of contents, you must update it by clicking Tools | Update | All Indexes And 

Tables.
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Navigate through your document

 

Cloud is fast becoming the new operational model for IT, and its transforming how business gets done. Nows the time to optimise for today and plan for 

tomorrow, with an IT infrastructure thats ready for the cloud when you are. 

If you are creating a complex document, you will want to take advantage of the LibreOffice Writer Navigator. This handy tool will allow you to click on an 

object within your document and immediately zip to that spot. The Navigator includes objects such as headings, tables, text frames, graphics, OLE objects, 

bookmarks, sections, hyperlinks, references, indexes, and comments. To get to the Navigator click View | Navigator or just hit F5.

Perform quick calculations

When a document requires some calculations, there's no reason to fire up a calculator or open up a spreadsheet. LibreOffice Writer has a formula toolbar 

that lets you perform calculations from within the word processor. The formula toolbar doesn't permanently reside in the toolbar section of LibreOffice. 

Instead, you view it, run your calculation, hit Enter, and the calculation will appear at your cursor. You can do the following calculations: sum, round, percent,

square root, power, various operators, and various basic and statistical functions.

Dock and undock your toolbars

A really cool feature is the ability to dock and undock toolbars. All toolbars can become undocked windows, which allows you to position them exactly 

where you want. Here's how you do it. Find a toolbar you want to serve as an undocked window. Hold down the Ctrl key and then double-click an empty 

spot on the toolbar. This will undock the bar which can now be moved around like a standard window. Repeat the action to re-dock the bar.
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Move text efficiently

Writer offers a really great way to copy a block of text to a new location within a document on't have to do copy/paste. Instead, highlight the text and then 

drag the text to wherever you want it. It is more efficient than the standard copy/paste method.
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Formatting tools

Paragraph
Indents and Spacing

Alignment
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Text Flow

Outline and Numbering

Tabs

Drop Caps

Borders

Area

Transparency
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